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Section 1: Introduction to the Snowflake Connectivity Guide

As a SHARP program participant, this guide is designed to help you connect to your desired
application through an ODBC or native connection to Snowflake. The guide will detail how to install
and configure an ODBC driver and establish an ODBC or native connection to access the data in
your Snowflake Account from an application such as Excel, Tableau, or Power BI.

Note: Generally, a native connection outperforms an ODBC connection; therefore, if an application
or tool supports native and ODBC connections, choose the native connection. For Tableau
specifically, a two-step process is required to establish a native connection: installing the ODBC
driver first (see section 2), then installing the native connector.

Permissions

e Toinstall the ODBC driver, you will need admin-level access on your device. If you do not
have admin access, you can submit an IT Help Desk Ticket for assistance in installing the
ODBC driver.

e To establish a native or ODBC connection, you will need your Snowflake credentials. Please
reach out to the SHARP IT Team DL_DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us if you
have not yet received your credentials.

The table below outlines which tools support native vs. ODBC connection.

A. Tool Connection Types

Native Connector ODBC

Tableau Desktop Yes Yes
ArcGlIS Pro No Yes
SAS Desktop Yes (need a separate subscription) Yes
SAS Viya Yes (need a separate subscription) Yes
Excel No Yes
Power Bl Yes Yes

R No Yes

Python Yes No

Section 2: Download the Snowflake ODBC Driver

To download and install the Snowflake ODBC driver, you need administrative-level privileges so that
the driver can be installed directly to the “C:\Program Files". If you do not have admin access, you
can submit an IT Help Desk Ticket here https://hhsconnection.hhs.texas.gov/it/help-desk, for
assistance installing the ODBC driver.

Generally, Helpdesk Support must install the Snowflake ODBC 64-bit driver. Reach out to the
Helpdesk Support Team should you need assistance installing the driver.


mailto:DL_DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us
https://hhsconnection.hhs.texas.gov/it/help-desk
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A. Click on the following link: Snowflake Repository (snowflakecomputing.com) and select the

Windows 64-bit folder.

Filename

L2

= linux

™1 linuxaarch64
™ mac64

™1 macaarch64
= win32
win64

B. Click on the “latest” folder.

Filename

| (]
[ (]
R R
(SR |

| -]
| ]
N
n

[~
(]
.
.

[+
]
I
%]

C. Click on the available file to download and run the file. Please contact your local IT

department if the download fails or you cannot run the file.

Filename

%+

snowflake64 odbc-2 24 7. msi

D. Continue through the driver setup making sure to install the Snowflake ODBC Driver to

C:\Program Files\Snowflake ODBC Driver\


https://sfc-repo.snowflakecomputing.com/odbc/index.html
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E. More instructions:
o Forinstalling and configuring the ODBC driver for windows, you can visit this page.
o For general information on connecting to Snowflake, follow this link.

Section 3: Configuring ODBC Driver
A. Global Protect (VPN) Users must follow the instructions below before proceeding. If you
experience a connection error that reads “443 error,” update the cacert certificate below. If
you update the file and still receive an error, please contact your IT Department and refer to
Section 5, B.
1) Copy the attached txt file (cacert.txt) to your computer at location - C:\Program
Files\Snowflake ODBC Driver\etc

cacert.txt

2) Move the existing cacert pem file to another location as backup
3) Rename the cacert.txt file to cacert.pem
B. Cisco AnyConnect (VPN) Users - no additional configuration is needed; proceed to C.

C. Inthe Windows Search Box, search for ODBC and select the ODBC Data Sources application

corresponding to the driver you downloaded above (64-bit).

Al Apps  Documents  Web More ¥

Best match

H ODBC Data Sources (32-bit)
" app

Apps

BS ODBC Data Sources (64-bit)

Search work and web

£ odbe - See work and web results

D. On the User DSN tab, select Add and scroll down to SnowflakeDSIIDriver.


https://docs.snowflake.com/en/user-guide/odbc-windows.html
https://docs.snowflake.com/en/user-guide-connecting.html

'-; QDBC Data Source Administrator (64-bit) x Create Mew Data Source
User DSN  Sys em DSN  File DSN  Drivers  Tracing Connection Pooling  About
User Data Sources Select a driver for which you want to set up a data source.
Name Platform  Driver Add.. 1 MNamie Vers ™
dBASE Files N/A Microsoft Access dBASE Driver {".dbf, “ndx, *m 1 | . -
Excel Files E4-bit Microsoft Excel Driver ("xls, "xlsx, “xlsm. " xlsb) Remove %" ODEC Driver 17 for SQL Server 201
MS Access Datsbase 64-bit Microsoft Access Driver (" mdb. ".acedb) oL PostgreSGL ANSI{x64) 9.06
Corfigure... Paostgre SGL Unicode(x64) 5.06
SnowflakeD S| Driver 224
SGL Server 10.0
SQL Server Native Cliert 11.0 2017
SQL Server Native Client RDA 11.0 201 7
< >
< >
m The driver of this User DSN does not exist. t can only be removed
— Bonly Help < Back | Finish Cancel

E. Configure Snowflake ODBC - configuration will depend on program association.
In the Snowflake Configuration Dialog box, fill out the following fields to configure the
ODBC Driver into a Data Source Name (DSN). Try using the Test button before pressing OK

to ensure the connection is working properly:

Snowflake Configuration Dialog *

| Data Source: I |
| User: I |
|
| Server: I |

| Database: I | |
| Schema: I | |

| Warehouse: I |
| Role: I |

Tracing(0-6): |

Authenticator:

Proxy: |
MNoProxy: |

Data Source (DSN): This field is unique to you and you may choose to name it how you
wish. This name will be referenced when connecting to tools mentioned in Section 2.

User: This is the username provided to you when your Snowflake access was provisioned.
Please reach out to DL_DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us for any assistance
with Snowflake Reader Account



mailto:DL_DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us

Password: This is your Snowflake Reader Account password

Server: The Snowflake Reader Account URL provided with your credentials
Database*:

Schema*:

Warehouse*:

Role*:

Note: * These details can be found within Snowflake GUI (logged in with your Snowflake Account) on
the Worksheets tab in the top right-hand corner and should be provided in the email with your
credentials. If you have access to multiple databases/roles, please be sure you use the appropriate
role and details to connect to the database you are trying to access.

Section 4: Connecting to Applications
To Use Snowflake through a Connection - the user must connect to the Snowflake application using
the DSHS-CISCO AnyConnect VPN. This is true for both ODBC and Native Connectors.

A. Connecting to Tableau Desktop with Native Connector

1. Download the ODBC Driver (see Section 2)
a. No DSN configuration is needed
2. Open Tableau and click Connect to data.
3. Select More under To a Server and search for Snowflake.

~

Connect
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4. Input your Snowflake credentials and press Sign In.
Server: The Snowflake Reader Account URL provided with your credentials
Role*:
Authentication: “Username and Password”
Username®*: Your Snowflake Reader Account username
Password*: Your Snowflake Reader Account password

Note: * indicates information that will be sent to you from a DSHS Tool Administrator once
you have been provisioned Snowflake access. If you experience any issues, please email
DL _DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us.

Snowflake

Server: dshs-sharp.snowflakecomputing. com

Role: | RLE SHARP YOUR WAREHOUSE READER |

Enter information to sign in to the server:

Authentication: Username and Password

Username:

Password: ‘ -------------- |

Enter custom driver parameters:

B. Connecting to ArcGIS Pro with ODBC
Snowflake data is available to load and use in ArcGlIS Pro. It is best to connect to Snowflake data
using ArcGIS Pro due to its modern design and, specifically, its 64-bit software architecture.

Contact DL_DSHS SHARP_IT_Ops_Support@hhsc.state.tx.us for help or questions.

1. Open ArcGIS Pro and open its Catalog


mailto:DL_DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us
mailto:DL_DSHS_SHARP_IT_Ops_Support@hhsc.state.tx.us

2. Right-click Databases on the left side of the Catalog screen and select New OLE DB
Connection.

CS= =T - v Manage

Catalog Insert Analysis View Imagery Share Databases

New Add i Data

- :: Refresh i To Ney - - - Sources
Clipboard Organize Create Update
n_» g Catalog X Ma | Map1 Map2
Contents = g 2] map [E] map [E] map
3 Add Database . i
= = &) W) » Project » Databases »
4 |y Project J Mew File Geodatabase e = |:| =
£ Name
2 Maps J New Mobile Geodatabase B
= g first20210518.gdb
& Toolboxe -J MNew Database Connection
~ i Q OLE DB Connection.odc

!

g > .[i Databast .3 New OLE DB Connection o |

g first20 New OLE DB Connection
"—' - P——
::1 OLED ~ Create a new OLE DB Connection to the proj
k- Refresh Th e e o the OLE
o Styles e project saves a reference to the OLE DB
connection file
B Servers
@ Folders

# Locators

4 A Portal

3. On the new Pop-Up, choose Microsoft OLE DB Provider for ODBC Drivers and click Next
4. On the pop-up screen, use the drop-down menu under Use data source name and select
the name of the new Snowflake ODBC driver (DSN Name created in Configuring ODBC

Driver section).

——
BB &o-c- s Manage
Catalog Insert  Analysis  View Imagery Share  Databases
+ | 2
-~ ﬁ
New Add Data | F =
~
> Refresh - . Sources &
Clipboard Organize Create Update
Contents ~ B x| Catalog % [F] Map FMapt  [F] Map2
© |
: (GIOIO » Project » Databases »
4 [ Project ©e@H
Name
© Maps -
@ first20210518,gdb
& Toolboxes 8 <
= | = Databases [¥] Data Link Properties H
b G first20210518.db Provider Connection Advanced All
v £ OLE DB Connection.odc Selectthe data you wantto connect o
& Styl
W Styies OLE DB Provider(s)
O Servers Microsoft Office 120 Access Database Engine OLE DB Provider
ol Microsoft Office 16.0 Access Database Engine OLE DB Provider
s Microsofl OLE DB Driver for SOL Server
# Locators Microznf 01 F DR Browiderfor Anahesic Sarvicas 141
4 @ Ratal == =] Microsoft OLE DB Providerfor ODBC Diivers = mumm.
WICIOSoN ULE UD Froviast or Searen
b & My Content Microsoft OLE DB Provider for SQL Server
My Faviiler Microsof OLE DB Simple Provider
MSDataShape
& My Groups OLE DB Provider for Micrasoft Directory Services
» 8 My Orgonization SOL Server Native Client 11.0
ArcGIS Online
@ Living Atlas
Favorites
Next>>
oK Cancel Help




5. Insert your username and password for Snowflake, then click Test Connection.

—

Bl & Data Link Properties X ‘

S

Provider Connection Advanced All

Specify the follawing to connectto ODBC data
1. Specify the source of dela
(@ Use data source name
~ | Refresh

(O) Use connection string

Build

2 Enter information 1o log on to the server

User name:

Password

[IBiank password [ Allow saving password

3. Enter the initial catalog lo use

Test Connection

oK Cancel Help

6. A pop-up will show Connection Successful. Click Ok to continue

Microsoft Data Link *

o Test connection succeeded.

oK

7. Click OK on the Data Link Pop-Up

SR e e g

B & Data Link Properties *
Provider Connection Advanced All

Specify the following lo connectto ODBC data:
1. Specify the source of dala:
@ Use data source name
| ~ | Refresh

O Use connection sking

Build

2. Enter information o log on to the server

User name:

Password

|:| Blank password |:| Allow saving password

3, Enterthe initial catalog to use

Test Connection

0K Cancel Help
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8. Right-click the new name in the Catalog Databases section. Choose the Rename and

change the name to something meaningful.

E e ge- = Manage
Catalog nsert Analysis View Imagery Share Databases
/71 X Remove X Delete - I‘-"__'.'a. /
# Rename Add To Favorites e |
Open _ » : . Data Edit
E‘ Copy Path x» Refresh [ Sort~ Add To New Projects . . - Sources
Clipboard Crrganize Create Update
Contents BN S Catalog > JANYEE || Map1 [F] Map2

i P
= (=) () » Project » Databases »
4 [p Project h — D =
Name
fi‘} first2021051¢ X Delete

£ OLE DB Connl #® Rename se—

I Maps
& Toolboxes

= Databases -'- ik
& OLE DB Conny & Refresh
b Ef first20210518.gdb =

X Remove
b & OLE DB Connection (2).odc
= Connection Properties

r &1 OLE DB Connection.odc
¢ Styles Properties
B Servers

Folders

# Locators

4 5 Portal

9. Open the Snowflake connection, and choose the necessary data.

C. Connecting to SAS 9.4 (Desktop) with ODBC
1. Using the DSN in Section 3, run the following SAS code to test the connection in SAS, then

look for the newly created object “LIBNAME" to confirm a successful connection.

libname mydblib odbc

noprompt="uid=YOUR USER ID;pwd=YOUR
PASSWORD; dsn= DSN NAME;"

stringdates=yes;

D. Connecting to SAS Viya with ODBC
1. Write the libname statement using your ODBC Data Source Name (DSN) as assigned to your

database and the associated username, password, and desired schema.



2. After running the SAS code to test the connection, look for the newly created object

“LIBNAME" to confirm a successful connection.

libname test odbc

dsn=DSN NAME CREATED IN SECTION

ID password=YOUR PASSWORD schema= SCHEMA NAME;

3 user=YOUR USER

E. Connecting to Excel with ODBC
1. Open an Excel Workbook and select the Data tab.
2. Select the drop-down for Get Data.
3. Select the option for From Other Sources.
4

Select the option From ODBC.

File Home  Insert  Draw  Pagelayout  Formulas  Data

™ Bisting Connecti
[ Eisting Connections e

Review  View |

[] Properties

T 0w Comnctins.
[ From Te/CSV [ Recent Sources p"
&
[B FromWeb =
A From Table/Ranae Al

[2 Edit Links

D From File »  Data

Bk reom e »
-
5 ?FrqunlineSgrvices 4

_ @ P

E E;E Combine Queries ’ I:'?@ From Web

P 57 Leunch Power Query Editor..

1 FR From Microsoft Query
Bl @ Data Catalog Search

B (i) My Data Catalog Queries [@ From SharePoint List

S (& Data Source Seftings..
§ 5] Query Options

E_‘?E From OData Feed

|:'§(1 From Hadoop File (HDFS)

S5

2|

I:Eq From Active Directory

v

From Microsoft Exchange

[‘gﬁ From OLEDB From ODBC

[E: Blank Query

0 [ [ [0 (a1 1o [ [ n2
B8N 85 RE8ERE

Queries & Cannections

Import data from ODBC.

5. Select the DSN (Data Source Name) you configured in Section 1.

6. Select the database and table you want to query.

F. Connecting to Microsoft Power Bl with Native Connector

12

1. Click START, navigate to the Microsoft Power Bl Desktop/Pro folder, and select the version of

Power Bl you are using.
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>
=
Windaws Windows.
Server Manager  PowerShell PowerShell ISE

-
Windows.
Administrativ... Task Manager Control Panel

M

EventViewer  File Explorer

2. Click on the Get Started prompt, followed by the option to Get data.

Power Bl PR

Tt & lool 3t what's niw and impaoved in Powes Blin

Desktop s e

POWER B BLOG

Kerp up o dabe with the st news, resounies, and
nit upcdates feam the Powet Bl tram.

FORUMS

Wiat the Powetr B Forum 10 ik queitions of interact
wath thier users in the Fewer Bl community

n other reports Collaborate and share

TUTORIALS
Ready to learn mone about Power BT

it statin

Want o buy a Power B liosnse? Suy now
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3. When prompted, search or find the Snowflake connection and click on Connect.

Get Data

[ snownake x Il

Al

Database

Configure the Snowflake connection details when prompted. Please use the provided figure
as an example and populate the data unique to your setup. You will also be prompted to

sign in with your Snowflake login credentials.

Snowflake

Server
tehhs.us-east-1-govaws.snoufiakecomputing.com

Warehouse

4Advanced options

Specify a text value to use as Role name (optional)

Tommand Gmeout i seconds (optonal]
Connection timeout in seconds (optional)

Include relationship columns (optional) [

v

S (o= |

To confirm a successful connection, navigate through the Navigator, choose a data table
you wish to work with, and click Load. If no error messages appear, you have successfully

connected to your data in Snowflake.



Navigator
Pt V_HPRC_AGE_DISTRIBUTIOMN_BY_GENDER &
Display Options ~ 2 AGE_CAT  YEAR PROFESSION MALE FEMALE
4 tehhs.us-east- 1-gov.aws.snowflakecomputi... . e 2020|Dental Assistant 173 A
b DEMO DB 55-60 2020 Dental Assistant 152
265 2020 Dental Assistant 55
4 [ SHARP_CHS_DEV DE[2] ;
61-65 2020 Dental Assistant 61
4 B8 CHS_HPR_HPRC_DATA [56] nul 2020 Dental Assistant 15
O TEMP_VW_TEST =25 2020 Dental Hygienist 14
& [ V_HPRC_AGE DISTRIBUTION BY GE... 26-30 2020 Dental Hygienist 79
175 V_HPRC_AGE_DISTRIBUTION_BY_RA... 3 2020 Dental Hygienist 1g
36-40 2020 Dental Hygienist 89
O3 V_HPRC_COUNTRY_OF_MEDICAL S...
41-45 2020 Dental Hygienist 64
O V_HPRC_FACT SHEETS ALL DATA 2650 2020 Dental Hygienist 0
1[5 V_HPRC_GEOGRAPHIC_DISTRIBUTI... 5155 2020/ Dental Hygienist a1
[m} [E V_HPRC_PRACTICE_HOURS 55-60 2020 Dental Hygienist 34
m] E W HPRC PRACTICE SETTING 61-65 2020 Dental Hygienist 32
L1 v HPRC_PRACTICE SPECIALTY >65 2020 Dental Hygienist 35
= B N N null 2020 Dental Hygienist 1
[0 V_HPRC_RACE_ETHNICITY_BY_PROF... s 2020| Dentint o
O3 v_HPRC_STATE_OF _TRAINING 2650 2020 Dentist 573
O V_HPRC_SUPPLY TABLES 3135 2020 Dentist 1718
O B T_CNTY DESIGNATION_TEMP 3640 2020| Dentist 2134
4145 2020 Dentist 2014
[/ T_HPR_HPRC_CHIROPRACTIC_LE T... s
2650 2020 Dentist 1590
CIE T_HPR_ HPRC_LB_AGING DISBLTY C... o s1ss 020| Deria 1208 v
[1E T_HPR_HPRC_LE_AGING_DISBLTY._... < >

Select Related Tables Load

G. Connecting to R with ODBC
1. Click START, navigate to the version of R you are using, and run the application as an

administrator.

W
PawerShel

Task Marusger “ontrol Panel

<! M

Event Viewer File Exploner
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2. Run the below command to install ODBC and other necessary packages to establish a

Snowflake connection.

R version 4.1.2 (2021-11-01) -- "Bird Hippie"
Copyright (C) 2021 The R Foundation for Statistical Computing
Platform: =86 64-wé4-mingw32/x€4 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type '"license()' or '"licence()' for distribution details.

Natural language support but running in an English locale
R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.
Type '"demo()' for some demos, '"help()' for on-line help, or
'help.start ()" for an HTML browser interface to help.

Type "g()' to guit E.

> install.packages(c("DBI", "dplyr™,"dbplyr","odbc™) ]|

3. When prompted, select the CRAN mirror, USA (TX 1) [https] and click OK (as shown below in
the diagram)

@ R Console | = || [|Secure CRAN mirrors
Germany (Erlangen) [https] ~

R version 4.1.2 (2021-11-01) —- "Bird Hippie" Germany (Leipzig) [https]

Copyright (C) 2021 The R Foundation for Statistical Computing Germany (Gottingen) [https]

Platform: x86_64-we4-mingwi2/x64 (64-bit) Germany (Mnster) [https]
Germany (Regensburg) [https]

R is free software and comes with ABSOLUTELY NO WARRANTY. Greece [https]

You are welcome to redistribute it under certain conditionms. Hungary [https]

Type 'license()' or 'licence()' for distribution details. leeland [https]
India [https]

Matural language support but running in an English locale ::’""[’;‘2;]03*‘“"”"“9’]
. . . . Italy (Milano) [https]

R is a collaborative project with many contributors. Italy (Padua) [https]

Type 'contributors()' for more information and Japan (Tekyc) [https]

‘citation()’ on how to cite R or R packages in publications. Korea (Gyeongsan-<i) [https]
Korea (Seoul 1) [https]

Type 'demo()' for some demos, 'help()' for on-line help, or Korea (Ulsan) [https]

'help.starc()' for an HIML browser interface to help. Malaysia [https]

Type 'qg()' to gquit R. Mexico (Mexico City) [https]
Mezico (Texcoco) [https]

» install.packages (c("DBI", "dplyr","dbplyr","odbe")) Morocco [https]

Installing packages into 'Di/Users/dalwalker/Documents/R/win-library/4.1" Netherlands [https]

(as '1ib’ is unspecified) New Zealand [https]

--- Please select a CRAN mirror £or use in this session --- Norway [https]

Russia (Moscow) [https]
South Africa (Johannesburg) [https]
Spain (A Corufia) [https]

< Spain (Madrid) [https]

Sweden (Boras) [https]

Sweden (Umed) [https]

Switzerland [https]

Taiwan (Taipei) [https]

Turkey (Denizli [https]

Turkey (Istanbul) [https]

Turkey (Mersin) [https]

UK (Bristal) [https]

UK (London 1) [https]

USA (1A) [https]

USA (KS) [https]

USA (MI) [https]

USA (OH) [https]

USA (OR) [https]

USA (TN) [https]
Uruguay [https]
(other mirrors) v
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4. Test the Snowflake connection by updating the details highlighted in yellow with your
credentials, then copying and pasting the code into the console.

library (DBI)
library(dplyr)
library (dbplyr)
library (odbc)

myconn <- DBI::dbConnect (odbc: :odbc (), dsn="DSN
CREATED IN SECTION 3”,uid="SNOWFLAKE
USERNAME”, pwd="SNOWFLAKE PASSWORD")

H. Connecting to Python with Snowflake Connector
Python allows you to connect to Snowflake via a Snowflake Connector or through SQL
Alchemy. You have the option to choose between either option.

1. Install the Snowflake Connector library using the following command.

pip install snowflake-connector-python

2. Substitute all highlighted areas with your credentials (reach out to sharp-

comm@dshs.texas.gov for any assistance needed) and execute the following code to

connect to Snowflake and read data from a table.

import pandas as pd
import snowflake.connector as snow

conn = snow.connect (user = SNOWFLAKE USERNAME,
password = SNOWFLAKE PASSWORD,

account = “SNOWFLAKE SERVER LINK”,
database = “SNOWFLAKE DATABASE NAME”,
schema = “SNOWFLAKE SCHEMA NAME”,
warehouse = “SNOWFLAKE WAREHOUSE NAME”)

cur=conn.cursor ()

sgl="USE ROLE SNOWFLAKE ROLE”

cur.execute (sqgl)

sgll="USE WAREHOUSE SNOWFLAKE WAREHOUSE NAME”
cur.execute (sgll)

sql2="USE DATABASE SNOWFLAKE DATABASE NAME"”
cur.execute (sql2)

sql3="USE SCHEMA SNOWFLAKE SCHEMA”
cur.execute (sql3)

sgql4="SELECT * FROM SNOWFLAKE TABLE NAME LIMIT 5”
cur.execute (sgl4)

#Closing the connection
conn.close ()



mailto:sharp-comm@dshs.texas.gov
mailto:sharp-comm@dshs.texas.gov
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I. Connecting to Python with SQL Alchemy

1. Install the SQL Alchemy library using the following command.

pip install snowflake-sglalchemy

from snowflake.sglalchemy import URL
from sglalchemy import create engine

engine = create engine (URL(
account = “SNOWFLAKE SERVER LINK”
user = “SNOWFLAKE USERNAME”
password = “SNOWFLAKE PASSWORD”
database = “SNOWFLAKE DATABASE NAME”
schema = “SNOWFLAKE SCHEMA NAME”
warehouse = “SNOWFLAKE WAREHOUSE NAME”
role = “SNOWFLAKE ROLE NAME”))

#Creating a snowflake connection using the parameters above
connection = engine.connect ()

try:
connection.execute (SQL CODE) - allows you to read data
finally:
connection.close() - closing the connection
engine.dispose() - closing the Snowflake engine created

2. Tovalidate the connection, substitute all highlighted areas with your credentials and run the

following code.
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4 Health and Human Services

Section 5: Additional Support

A. Help Desk Ticket Template to DSHS IT Department: ODBC Installation Request

If you need assistance downloading and installing the Snowflake ODBC Driver to your machine,
please feel free to use this template below when creating a help desk ticket for your IT department.

Reminder, if you do not have administrative privileges or the download fails, you will need to contact
your IT Department.

IT Help Desk: https://hhsconnection.hhs.texas.gov/it/help-desk

Ticket Body:
Hi,

| am requesting assistance with downloading and installing Snowflake’s ODBC Driver. This ODBC
Driver Install is a prerequisite to accessing the data available in Snowflake via our desired tools. Here
is a link for reference: Installing and Configuring the ODBC Driver for Windows — Snowflake
Documentation.

Thank you!
B. Help Desk Ticket Template to DSHS IT Department: 443 Error

If you receive a “443 Error” while configuring the Snowflake ODBC Driver to your machine, please
follow Section 3. A: 1-3 on saving the cacert file. If you still face the error after saving the cacert file,
you may need the assistance of the IT Department to send an updated cacert file.

IT Help Desk: https://hhsconnection.hhs.texas.gov/it/help-desk

Email Body:
Hi,

| am requesting assistance with downloading and installing Snowflake’s ODBC Driver. While
configuring the driver, | received a 443 error. After saving the cacert file to my machine, | still
received the 443 error. Here is a copy of the cacert file for reference:

cacert.txt

Thank you!

C. Additional Documentation

1. Installing and Configuring the ODBC Driver for Windows — Snowflake Documentation



https://hhsconnection.hhs.texas.gov/it/help-desk
https://docs.snowflake.com/en/user-guide/odbc-windows.html
https://docs.snowflake.com/en/user-guide/odbc-windows.html
https://hhsconnection.hhs.texas.gov/it/help-desk
https://docs.snowflake.com/en/user-guide/odbc-windows.html

a. Documentation from the Snowflake website on downloading, installing, and
configuring your ODBC driver.

2. Connecting to Snowflake — Snowflake Documentation

a. Documentation on how to connect 3™ party tools and applications to Snowflake.

20


https://docs.snowflake.com/en/user-guide-connecting.html

	Section 1: Introduction to the Snowflake Connectivity Guide
	A. Tool Connection Types

	Section 2: Download the Snowflake ODBC Driver
	Section 3: Configuring ODBC Driver
	Section 4: Connecting to Applications
	A. Connecting to Tableau Desktop with Native Connector
	B. Connecting to ArcGIS Pro with ODBC
	C. Connecting to SAS 9.4 (Desktop) with ODBC
	D. Connecting to SAS Viya with ODBC
	E. Connecting to Excel with ODBC
	F. Connecting to Microsoft Power BI with Native Connector
	G. Connecting to R with ODBC
	H. Connecting to Python with Snowflake Connector
	I. Connecting to Python with SQL Alchemy

	Section 5: Additional Support
	A. Help Desk Ticket Template to DSHS IT Department: ODBC Installation Request
	B. Help Desk Ticket Template to DSHS IT Department: 443 Error
	C. Additional Documentation


